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A PERSONA IS a document that describes the ways in which certain types of people will use 
your website. Usually one persona is created for each type of user. Personas are used to show 
you the goals that users will be trying to achieve on your website. See Figure 1-1.

In this chapter, you will learn exactly what information is needed to create a truly useful 
persona. You will learn the best time in which to produce your personas, what information 
needs to be communicated, and how to lay it out in a clear and concise way. You will also get 
some ideas on how to generate the information that is needed to create a solid persona that 
is based on real people.

Figure 1-1: A persona helps you understand users’ goals when using your website.
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What makes a good persona?
A good persona is based on real people and solid research. It focuses on the key goals that 
user groups have to achieve, user behaviors, and user attitudes while completing their goals.

Ultimately, personas need to help you understand if any decisions you make will help or 
hinder your users.

When to create a persona
To put it plainly, you should create one now. Unlike wireframes or prototypes, personas 
don’t fi t into a specifi c part of a single project process. Instead they help guide every part of 
every project. Th ey provide a quick reference for design decisions, idea generation, and stra-
tegic changes.

Personas and task models sit closely alongside each other and are built on the same types of 
research, so for effi  ciency the two can be developed side-by-side—this also allows you to 
consider diff erent personas based on the task models.

Personas should be living documents. Th ey capture a snapshot of an audience at a specifi c 
time. As further research uncovers new insights, your personas need to be updated to refl ect 
them. Doing so turns the personas into an ongoing strategic tool that constantly represents 
the user behavior and uncovers new opportunities.

What are you communicating?
A persona has two goals:

> To help you make design decisions.

> To remind you that real people will be using your system.

A good persona is not based on demographics or stories; it’s based on the tasks, behaviors, 
and attitudes of your users. For example, if you’re developing a vacation reservation site, 
your personas shouldn’t focus on what newspapers users read, what cars they drive, and 
what the measurements of the inside of their legs are. Th is information doesn’t help you 
develop your product. Avoid irrelevant information; focus on key goals. Th is helps you imag-
ine how people will use your product—and that helps you make it more useful to them.
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Use short descriptive bulleted points
Avoid stories. Don’t get me wrong, I love stories, but not in personas. Th e problem with sto-
ries is it’s diffi  cult to write them well and people won’t take the time to read them unless they 
are incredibly engaging. Keeping your persona content down to short sentences and bullets 
creates less eff ort for the reader.

Base personas on real people
Personas should be based on real people from real research. A good way to ensure this is to 
use somebody you met during your research as a base for your persona. Choose somebody 
who is a fair representation of the persona and then add in any other relevant pieces of infor-
mation you found in your research. Th is means your persona shows a fair representation of 
the group it’s representing but uses real examples that you have really experienced.

Use descriptive photography
Photos can be a really valuable part of a persona, but more often then not they are used really 
badly. Mostly photos are used to put a human face against the persona, so a cheesy smiling 
portrait is stuck at the top of it. Photos on personas can do much more than that.

Th e right photo can tell the reader something about this user group just from looking at it. 
For example if one of your personas has a hard time using technology, then the photo should 
be of someone struggling to use technology. Photos in your personas should refl ect user 
behavior, not just age and gender.

Avoid using stock images. Th ey are tacky and make your personas feel less real (real people 
don’t stand in studios with cheesy grins). Ideally you want to use photos of real users who 
you encountered during ethnographical research (explained later in this chapter). Photos of 
real users performing relevant tasks will help ground your personas in reality. Of course this 
is not always possible. An alternative is to use an online photo sharing site like Flickr. Th ese 
have a wealth of candid photos of real people in real situations. However, you need to be 
aware of the licensing that is associated with the images and may need to seek permission 
from the photographer before you use them.

Figure 1-2 shows an image from a persona for a shopping site.

A nice addition is to include a photo of the personas’ environment. If you show the space 
that they inhabit while trying to use your system, you might come up with some interesting 
ideas of their behaviors and constraints. It could tell you if they work in a messy environ-
ment that is full of distractions. It could show you the kinds of devices they use: laptops or 
mobiles. It could show you any other resources they use to complete their goals: books, bro-
chures, or notepads. Figure 1-3 shows an example environment image for a persona.
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C H A P T E R  O N E  P E R S O N A S 13

Figure 1-2: Th is example shows their clothes shopping behavior as functional (just buying socks and pants).

Figure 1-3: Th is is the actual desk of co-author Steve Cable. What’s it tell you about his environment?
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Anatomy of a persona
Here’s a breakdown of what you need to include in your persona. Figure 1-4 shows examples 
of the concepts that follow.

Photos
Use representative photos that put a human face against the persona and also tell the reader 
something about the person behind the persona.

Persona names
A name humanizes the persona, but also makes it easy to know which you are referring to in 
design meetings: “Th is idea would work for Ken, but not so much for Deirdre.”

User quotes
A quote from somebody you met during research can bring the persona to life and give a 
quick overview of that persona’s state of mind when trying to complete her goals.

Key goals
If you know what people want do on your website or with your software, you can ensure you 
have everything in place to make sure they can do it. Diff erent personas will have a diff erent 
number of goals, but generally you want to know the answer to these questions:

> Do they have a specifi c task to complete quickly?

> Do they want to take their time and enjoy the experience?

> What do they need to know?

> What is their ultimate goal?

Behaviors
Knowing what motivates people and how they are likely to be feeling helps you create per-
suasive designs that will infl uence choices and help reduce any worries they may have. Look 
for answers to the following questions:

> What are their motivations for using the system?

> What are they likely to be feeling when they use your system? (Do they assume it’s 
going to be a frustrating experience?)

> Do they have a lot of spare time to perform their tasks?
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> What infl uences their choices?

> What puts them off  or makes them lose trust?

Must dos
A must do is a simple description of what you need to do to support your users’ key tasks and 
behaviors. Th ese must be about your system or service as a whole because they can be used 
to validate any design decisions or new functionality.

Must nevers
A must never is the same as a must do, except it focuses on what you must avoid at all costs. 
Avoiding any of the points in your must never section will help prevent designing a system 
that will make your users feel lost or confused.

Figure 1-4: A completed persona that focuses on user goals and behaviors. 
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Who is the audience?
Personas are for anybody who needs to make a decision about the design of your system, or 
a decision about your strategy as a whole. A well-researched persona can help inform these 
decisions.

Th ey are especially useful for companies that don’t know anything about their customers. It 
gives you a chance to think about why you are doing what you are doing.

Experience shows that it’s important to get buy-in from senior stakeholders when creating 
personas. Th is ensures they aren’t forgotten and left to gather dust on the shelf. Getting buy-
in does not mean showing the personas off  once they are completed.

It’s important to get senior stakeholders involved in the process early on. Invite them to 
research and testing sessions so they can see for themselves some of the behaviors and goals 
that will be presented in your personas. Th at way they will see where the content of the per-
sonas is coming from and believe in them more than if they were just slapped on their desk 
after six months of research behind closed doors.

Personas are also very useful for internal or external research teams. If any user research is 
being carried out, the persona is a very useful tool for recruiting test participants. Goal-based 
personas allow you to recruit users based on those goals. For example, when testing a travel 
website you will recruit users whose goal is to book a long holiday for a family, and some 
users whose goal it is to book a short break for a couple.

As shown in Figure 1-5, it’s useful to keep personas readily available, or on constant display, 
to allow project teams to reference them when making design decisions.
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Figure 1-5: A handy display of user personas. 

How to validate personas
Personas are based on lots of research so initially they will not need validation. But as time 
goes on, you need to be sure your personas are still relevant.

For quick validation you can always run your personas past the customer service team or call 
center staff . Th ese are the people who have the most contact with your users; they will be 
able to see if your personas ring true with what they experience, or just never happen.

Personas can also be validated against any other research that gets carried out for any other 
projects within your company. If you’re performing some usability testing to fi nd some quick 
wins or online surveys to gather customer experience information, you can evaluate the 
results with your personas. Comparing your results will show if new fi ndings are consistent 
with your personas, making the personas still relevant. If the fi ndings are inconsistent with 
your personas, then they may need updating. However at that point it would be safest to 
perform more specifi c validation research to be sure.
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RESEARCH AND WORKSHOP IDEAS
Th e key to a good persona is research. Without that, personas are guaranteed to fail. Personas 
that are simply made up are easy to spot and are easily forgotten about.

Start with a theory
So you need to talk to lots of people, but who do you talk to? You don’t have your personas 
yet to know what types of people use your system, right?

You need to start with a hypothesis. Th eorize what the core goals are and recruit research 
participants based on those goals.

Base your theories on what your company already knows—no matter how little the informa-
tion might be—about its customers or users. Th ink of what kinds of goals you assume they 
need to complete and what kinds of scenarios these people may be in. For example, if you’re 
running research for a mother and baby retailer, don’t just recruit based on goals like, “Needs 
to buy a crib,” or “Needs to buy a stroller.” Instead, recruit based on wider scenarios and 
goals, such as:

> First-time mother trying to buy everything she needs.

> Mother of two or more who needs to make a large necessary purchase.

> A relative looking for a gift for a mother.

Your goals must also cover all relevant aspects of the project.

Once you have a theory, carry out your research. Your research will either prove or disprove 
those theories.

tip The more research you do, the more accurate and robust your personas become. This 

creates a trade-off  between budget and quality. To have personas, you must do research, but 

a six-person usability test will not be enough.

Th e following sections provide a brief overview of some ways that you can gather informa-
tion to create your personas.
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RESEARCH TECHNIQUE: Listen in on call centers
If you have a call center available, it is a great resource for listening to the questions and 
needs of lots of users in a short space of time. However, you don’t get the same level of infor-
mation as depth interviews. Th e idea is to listen in and not interact. Note what people are 
calling for, the questions they have, and the information they need. By the end of the day 
you should see patterns and themes emerging. If we use the mother and baby retailer exam-
ple, then you will want to listen for:

> Th e types of products they’re trying to buy.

> Th e information they want to know about the products.

> Th e problems they face when trying to buy those products.

You can do call center listening remotely by dialing in, but it’s much more benefi cial to go to 
the call center in person (see Figure 1-6). Th is allows you to talk to the call center staff . Th at’s 
important because they are going to know the most common problems that callers have and 
the most common questions asked. Hopefully this will ring true with what you have been 
hearing and seeing in other research. You can also learn the solutions that call center staff  
provide to people.

Specifi cally, you want to fi nd out the following information from the call center staff :

> What are the most common problems or complaints?

> What are the solutions you give to people?

Figure 1-6: Listening in on calls between customers and call center staff  can quickly uncover common issues and 
user goals.
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RESEARCH TECHNIQUE:  Conduct depth interviews
Depth interviews allow you to speak to only a small number of people, but as the name sug-
gests, you can gather some in-depth information.

Th e idea is to get users to talk to you about their previous experiences when trying to com-
plete goals relevant to your system. You need to talk to the theorized groups of users you 
initially defi ned (for example, fi rst-time mother, mother of two or more, and somebody buy-
ing a gift for a mother). Discuss what they remember from the last time they completed their 
goal. In particular you want to know:

> What information did they need to know?

> What problems did they encounter?

> What were they able/unable to do?

> What tasks were involved in achieving their goal?

> What did they use to achieve their goal (websites, books, other people, for instance)?

> If they were going to attempt to achieve that goal again, how would they do it?

Th e rich, qualitative information you gather will give you an idea of the kinds of themes that 
may go into your persona, but because the numbers are small you may need to use other 
techniques to get more results to validate those themes.

RESEARCH TECHNIQUE:  Conduct ethnographic research
What we mean by ethnographic research is simply watching (and talking to) people trying to 
achieve their goals in their natural environment (for example, an in-depth interview in their 
natural environment). 

We once did some research for eBay, trying to understand the goals and needs of users who 
sold the most stuff  on the site. Rather than getting them into the lab, we went to their 
homes. Th is meant we could see the type of environment they worked in, which helped build 
an idea of any constraints they might have. We also could be shown things, rather than just 
talk about things—like what they were currently trying to sell and how they went about try-
ing to describe it on eBay. 

For the mother and baby retailer, a good place to do an ethnographic study is in their stores 
(with permission from the company, of course). Subtly follow customers in order to see what 
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they are buying (if anything). Listen to conversations they have with shop staff . Th is can help 
you understand customers’ decision processes. It’s also a good idea to talk to the store staff  
at the end of the day about what you have discovered. Th is will help validate your fi ndings 
and draw out more stories about customer behavior.

Ethnographic research is great for getting a good depth of information from a small number 
of people. You also learn many things from people in their natural spaces that you wouldn’t 
in a lab environment.

WORKSHOP IDEA: Defi ne your personas
By this point you will have recruited participants based on the goals you identifi ed for using 
your system. You will have spoken to them about how they perform those goals and discovered 
the behaviors they use. Now you need to take this information and group it into personas.

Take the notes from the individuals you have interviewed and cluster them by the goals set 
during recruitment. For example, group all the people who were recruited because they were 
fi rst time mothers trying to buy everything they need and group all the people who were 
purchasing gifts for mothers.

Focusing on one group at a time, look at the diff erent approaches people took to completing 
the goals you set. You may see that everybody went about completing the goal in the same 
way. However, you may often fi nd that diff erent people approach the same goal in diff erent 
ways and may even have diff erent goals. For example, buying clothes may split into those 
people who relish the opportunity and enjoy the process, and those people who buy clothes 
for necessity only—two very diff erent approaches to the same goal.

Once you have your fi nal list of personas, you need to determine their behaviors. Go through 
the notes for each persona at a time, pick out the interesting behaviors, write them onto 
Post-Its, stick the Post-Its up on a wall (see Figure 1-7), and group the interesting behaviors 
that appear frequently. It is a good idea to base your personas on one specifi c participant and 
enrich it with the fi ndings from others.

Determining must dos and must-nevers is left until last because they are based on the key 
goals and behaviors. You need to think about how you can help this user and how you can 
avoid frustrating and confusing him. Remember to not be too specifi c. If you include a must 
do such as, “Must use red on the call to action on the product page,” that will help only with a 
specifi c decision. Th ese rules must be broad enough to help with decisions across the whole 
site, system, or even the business. For example, “Must never overwhelm the user with choice.”
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Figure 1-7: Using Post-Its to group interesting behaviors helps to show common themes from your research.

What’s the simplest way to create a persona?

The actual design of the persona document should be pretty simple anyway. What really 

counts is the quality of the data that sits behind it. If you are really pressed for time or need 

to get a brief preview out ahead of the fi nal document, here is a quick way of presenting 

personas using Microsoft Word.

Persona images

The best way to save time and effort is to use alternatives to photos. If you didn’t collect 

appropriate photos during research, sourcing ones that are good enough can be time con-

suming and diffi cult. As an alternative, you could use icons to represent each persona. This 

isn’t as personal as a photo, but at least each persona will be easily distinguishable when all 

are stuck up on the wall.

Document titles

Use the persona name as the document title. It’s always a good idea to use the name of a 

participant you met during research to keep it realistic. (Also, you’ll fi nd you will get hung up 

on selecting a name.) Use a large font (48 points) so it can be easily read when stuck on a wall.
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Use a quote from the user as a subtitle. Make the font size smaller than your title (22 

points). This is a supporting piece of information, so give it less emphasis than everything 

else by making the font a lighter shade of gray. Use italics and quotation marks to make it 

clear that this is a user quote.

Subheadings

Create a subheading for each of the key areas of information (Key Goals, Behaviors, Must 

Do, Must Never). Use a smaller font again (18 points).

Bulleted lists

Use bulleted lists to display the information in each section. This is both an easier way to write 

and an easier way to read. To create a bulleted list, write each point on its own line. Highlight 

the text you want to make in to bullets and in the top menu select the Home tab, then click on 

Bullets. From here you can choose what style of bulleted list you want. It’s best to avoid num-

bered lists for your bullets unless the points you are making have some kind of prioritization. If 

you want to tweak the line spacing between each point, highlight the bulleted text, right-click 

it, and select Paragraph. You can edit the Line spacing options in the window that pops up.

Figure 1-8 shows a persona created in Word.

Jason 
‘I just want to buy what I need and get out’ 

Key Goals 
• Knows what he wants to buy  

• Avoid spending time browsing 

• Get something balanced between price and quality (look is not 

so important) 

 

Behaviors 
• Gets bored shopping quickly, whatever is good enough will do 

• Wants tried and trusted products  

• Happy to let others do the thinking for him 

• Easily influenced by discounts 

 

We Must 
• Clearly show the key features of each products 

• Provide easy comparison between products 

• Show him relevant offers 

 

We must never 
• Don’t focus on fluffy descriptions of products 

• Don’t overwhelm him with choice 

Figure 1-8: If you’re short on time, you can use Word to create a persona.

04_9781119971108-ch01.indd   2304_9781119971108-ch01.indd   23 8/10/11   8:33 PM8/10/11   8:33 PM



C O M M U N I C A T I N G  T H E  U S E R  E X P E R I E N C E 24

HOW TO Create personas in PowerPoint
Th is section shows you how to create a persona layout that you can reuse for each of the 
personas you create. Th e instructions describe how to create the personas in PowerPoint 
2010. 

note Mac users can either use the Mac version of PowerPoint or skip to the OmniGraffl  e 
tutorial, which shows how to create the same document.

Creating and setting up the slide presentation
To create a new slide presentation and set it up correctly, follow these steps:

1 Go to the File tab and click New. A menu of document templates and themes is displayed.

2 Th e Blank presentation should be highlighted by default. (If not, click it.) Click the Create 
button on the right (see Figure 1-9).

Figure 1-9: Creating a new Blank presentation.
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Th e default presentation uses a landscape layout. Th e persona design uses a portrait layout, 
so you need to change this setting.

3 Go to the Design tab and in the Page Setup group, click Slide Orientation and then choose 
Portrait.

4 Go to the View tab and in the Show group, select the Guides option.

When Guides is enabled, the page is divided both horizontally and vertically. Th is will help 
divide the page vertically to give equal space to both the persona image and the persona 
information.

5 On the Power Point slide, select the Click to add title box and delete it.

6 Click to add subtitle box and delete it as well.

caution Make sure you delete the text boxes, not just the text that sits within them.

Adding persona images and titles
Th is section describes how to add images into your persona, how to resize images, and how 
to create the page titles.

Inserting an image
To insert the persona image:

1 Go to the Insert tab and click the Picture button.

2 Select the image you want and then click Open.

3 Click the blue corner points of the image to resize it, making sure you hold down the Shift 
key as you resize the image. Th is retains the same aspect ratio and ensures the sizing isn’t 
warped.

4  Drag the corners of your image to resize and position your image so it takes up the top 
half of the page and the person in the photo is over to the left or right of the slide. Th is 
means you will have you will have space on the opposite side to overlay a title.

note Don’t worry if your image spills over into the bottom of the page. You can crop it to 
stop this from happening.
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5 To crop the image, select the image and then in the Picture Tools Format tab, select Crop 
(see Figure 1-10). Th e controls around the edge of the image will change. 

6 Drag the black lines on the edge of the image to crop it. Th ey should snap to the edges of 
the page and the guidelines. 

7 Once you’re happy with your crop, just deselect the image.

Click and
drag these
to resize the
image

Click and
drag these
to crop the
image

Figure 1-10: Use resizing and cropping to make the persona image take up the top half of the page.

Adding an overlay color

Before you add the document title, add a transparent block of color over part of the image to 
make the text more readable.

1 In the Home tab, select a rectangle from the shapes menu and draw a rectangle over the 
top of your image.
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2 With the shape selected, go to the Shape Fill drop-down, select Gradient, and then choose 
More Gradients.

3 From the Fill menu, select Gradient fi ll. Set the following (see Figure 1-11):

• Type drop-down: Linear

• Gradient stops: white (select each and choose white from the Color menu 
below)

• Transparency of right stop: 100%

• Transparency of left stop: 20%

• Transparency of middle stop: 20%

4 Click Close when you’re fi nished.

Figure 1-11: Adding a transparent overlay to the image.

Inserting a title
To insert a title, follow these steps:

1 Click the Insert tab and in the Illustrations group, click the Shapes down arrow.

2 In the Recently Used Shapes category, click the text box.

3  Click wherever you want to type.

4 Use your personas name as the document title.

5 Make the title large (60 points). Use a font that is easy to read, such as Arial. 
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note Your personas are likely to be viewed as PDFs. If you use a font that is specifi c to a Mac 
or specifi c to a PC, a user who isn’t using the right operating system might have diffi  culty 
reading the font. 

6 Change the font color to a dark gray and position the text box in the top corner of the 
page over your gradient.

7 Repeat Steps 5 and 6 to add your user quote except this time use a smaller font (28 points) 
and use italics and quote marks to make it clear that it’s a quote.

See Figure 1-12. Play around with the size and position of your titles to see what looks good 
against the background image.

Figure 1-12: Place your title and subtitle over the transparent overlay.

Adding icons, subheadings, and bulleted lists
Each group of information in the persona (for example, Key Goals) will need an icon to illus-
trate each group of information, a clear subheading, and a bulleted list to display the infor-
mation. Use the same positions for subheadings and icons across all your personas; this will 
simplify the comparison of each persona.
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Inserting icons
Th e icons should be the same size, fairly small, and a light gray. Th ey should illustrate the 
heading but should not take attention away from more relevant information. 

note The icons used in this example are available to download along with many others 
from the book’s supporting website.

1 Go to the Insert tab and click the Picture button.

2 Select the icons you want and click open. When all the icons have been added to the slide, 
select them all. 

3 Resize them by going to the Picture Tools format  tab and using the size controls on the 
right of the menu. Set all the icons to 1.5 cm by 1.5 cm (see Figure 1-13). 

4 To change the icons to a lighter gray, select one and in the Adjust group, click the 
Corrections menu.

5 Select the Picture correction options and reduce the contrast by 100%.

Figure 1-13: All icons should be the same size and color.

04_9781119971108-ch01.indd   2904_9781119971108-ch01.indd   29 8/10/11   8:34 PM8/10/11   8:34 PM



3
0

C
O

M
M

U
N

IC
A

T
IN

G
 T

H
E

 
U

S
E

R
 
E

X
P

E
R

I
E

N
C

E
 

Adding subheadings
Now add the titles for each section of information:

1 Make the font size 24 points and change the color to a light gray to match the icons (see 
Figure 1-14).

Figure 1-14: Subheadings are set to 24 point and the color is changed to light gray.

2 To make sure the icons and titles are all aligned nicely, click the Home tab and in the 
Drawing group, click Arrange and choose Align.

Adding bulleted lists
Use bulleted lists for the main pieces of information. Th at makes the information much 
quicker and easier to read. To create a bulleted list, follow these steps:

1 Create a text box.

2 Type your information into the text box.

3 Select all of the text in the box.
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4 Click the Home tab and in the Paragraph group, click the Bullets button and choose round 
bullet points (see Figure 1-15).

Figure 1-15: Th e round bullet points are simple yet also eff ective at helping each point stand out visually.

You can adjust the distance between the bullets and the text by clicking into the text box and 
dragging the markers on the rulers at the top of the page. It’s also a good idea to increase the 
line spacing to make each point more readable:

1 Select the text box and click the Home tab.

2 In the Paragraph group, click the Line Spacing button and then click Line Spacing Options 
(see Figure 1-16).

3 In the Spacing group, change the After setting to 6 pt.
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Figure 1-16: Th e line spacing options give you more control over the space between bullet points. 

Make the font around 14 points depending on how much text you need to fi t in. Change the 
color to a darker gray than all the other text because these are the most important pieces of 
information.

For each of your subsequent personas, just duplicate this page by right-clicking the slide in 
the preview panel on the left and clicking Duplicate Slide (see Figure 1-17). You just need to 
change the photo and all the necessary text. It’s best to leave as many elements as possible in 
the same place to make all the personas consistent.
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Figure 1-17: Th e fi nished layout can be duplicated and reused for each of your personas. 
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HOW TO Create personas in OmniGraffl e Pro
Th is section explains how to create a persona using OmniGraffl  e Pro. You will learn how to 
set up the document and add all the necessary images and text elements to create a persona 
template that can be reused for all the personas you create.

Creating and setting up the presentation
To create a new presentation and set it up correctly, follow these steps:

1 Go to the File menu, click New, and then select the blank document from the template 
chooser.

2 Go to File and choose Page Setup.

3 For the Paper Size setting, select A4 (see Figure 1-18).

4 For the Orientation setting, choose Portrait.

Figure 1-18: Set up the document as a printable size because most personas exist as print outs stuck on walls.
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Finally, you want to set some guides up that run down the center of the Canvas horizontally 
and vertically. Th is helps you line all your information up and provides you with equal space 
to the persona image and the persona details.

5 Go to the View menu and make sure Rulers and Guides are turned on. Th ey should be 
enabled by default.

6 Set your guidelines to 280 px horizontally and 390 px vertically (see Figure 1-19).

Create new guides
by clicking and
dragging the rulers

Figure 1-19: Setting your guides to these locations helps align all the information as it’s added into the persona. 

Adding persona images and titles
Th is section explains how to add and resize images as well as how to add the titles and subtitles.

Inserting an image
To add images into OmniGraffl  e, simply drag them from the fi nder window onto the canvas.
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Once you have placed your persona photo onto the canvas you will need to resize and crop it 
to so it takes up the top half of the page. Here’s the best way to do that:

1 Select the image and, in the image section of the inspector, click the Natural size button 
(see Figure 1-20). Th is masks the image allowing you to determine the area you want your 
image to take up and easily crop it to fi t.

2 With Natural size selected, resize the border around the image so it covers the top half of 
the page, and then use the Size slider in the inspector to resize the image to fi ll the space.

Click the Natural
Size button to
create a crop area

Drag the thumbnail
to position the
image within the
crop area

Drag the Size slider
to resize the image

Figure 1-20: Use the Natural size options to make sure your persona image takes up the top half of the page.

note It’s a good idea to make sure the person in the photo is over to the left or right of the 
image. This means you will have space on the opposite side to overlay a title.

Adding an overlay color
Before you add the title to the image, add an overlay color to make any text that sits on the 
image more readable:

1 Draw a rectangle over the half of the image that doesn’t have the person in it

2 Open the stroke options in the style section of the inspector and uncheck the Stroke 
checkbox (the line around the shape).
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3 Open the shadow options in the style section of the inspector and uncheck the Shadow 
checkbox.

4 Open the fi ll options in the style section of the inspector. Click the Fill type drop-down 
and change the Fill type to Double Linear Blend. Use the Angle text box to change the 
angle of the gradient to 0 degrees.

5 Click the color boxes on the right of the inspector to change all three colors in the gradient 
to white; change the Opacity of the top two to 80% and the bottom one to 0%.

6 Drag the slider next to the gradient colors in the inspector down a fraction to make the 
lighter part of the rectangle stand out a little more. See Figure 1-21.

Select the Double
Linear Blend option

Drag the slider to
change the position
of the gradient

Type the angle for
the gradient here

Figure 1-21: Adding a transparent overlay on your image means any text you put on top of it will be more 
readable.

Inserting a title
Next, add the persona name and quote. It’s best to use the name as the title of the page and 
the quote as a subtitle. Add a text box over the gradient and use a large font (around 64 
points) for the title. For the quote, use a smaller font in italics and quote marks. Play around 
with the size and position of your titles to see what looks good against the background image. 
See Figure 1-22.
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Figure 1-22: Place your title and subtitle over the transparent overlay.

Adding subheadings and bulleted lists
Each group of information in the persona (for example, Key Goals) will need an icon to illus-
trate each group of information, a clear subheading, and a bulleted list to display the infor-
mation. Use the same positions for subheadings and icons across all your personas; this will 
simplify the comparison of each persona.

Inserting icons
Th e icons should be the same size, fairly small, and a light gray. Th ey should illustrate the 
heading but should not take attention away from more relevant information. 

note The icons used in this example are available to download along with many others 
from the book's supporting website at http://cxpartners.co.uk/resources.
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1 When all the icons have been added to the document, select them all.

2 Resize them by going to the Properties: Geometry section of the inspector and changing 
the height and width to 50 px (see Figure 1-23).

3 To gray the icons, open the Style: Image section of the inspector and reduce opacity to 50%.

Figure 1-23: All icons should be the same size and color.

Adding subheadings
Now add the titles for each section of information:

1 Make the font size 24 points and change the color to a light gray to match the icons.

2 Make sure the icons and titles are all aligned nicely by opening the Canvas: Alignment 
section (see Figure 1-24) and aligning the icons horizontally with the titles.
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Use the alignment
controls to align
icons horizontally
with the titles

Figure 1-24: Align the icons horizontally with the titles.

Adding bulleted lists
Use bulleted lists for the main pieces of information. Th is makes the information much 
quicker and easier to read. To create a bulleted list:

1 Create a text box.

2 Type your information into the text box.

3 Select all the text.

4 Click the Lists drop-down menu at the top of the canvas and select the round bullet style 
(see Figure 1-25).

You can adjust the distance between the bullet and the text by selecting all the text and drag-
ging the arrows in the rulers at the top of the canvas (also refer to Figure 1-25).
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With the text 
selected, drag these
arrows to adjust the
indent of the text

Figure 1-25: Selecting the round bullet style and adjusting indents.

It’s a good idea to adjust the line spacing between the bullets to make everything easier to 
read:

1 Select all the text and click the Spacing drop-down menu.

2 Click Other.

3 Adjust the Paragraph spacing after setting to 6.0 points (see Figure 1-26).

For each of your subsequent personas, just duplicate this page by right-clicking the slide in 
the canvas list panel on the left and clicking Duplicate Canvas (see Figure 1-27). You just 
need to change the photo and all the necessary text. It’s best to leave as many elements as 
possible in the same place to make all the personas consistent.
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Figure 1-26: Use the Paragraph spacing after settings to keep the text aligned to the top of the text box.

Figure 1-27: Th e fi nished layout can be duplicated and reused for each of your personas.
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